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Requesting permission to reproduce figures and tables from other sources is the 
responsibility of the author, as is payment of any fees the copyright holder may 
require before granting permission. Authors should never assume that material 
taken from software or downloaded from the Internet may be used without ob- 
taining permission. 

1. Permission to reproduce material must be obtained during the writing stage. 

2. Classify all information from another source as either “in the public do- 
main” or “requires copyright permission.” 

• Publications from federal agencies are all in the public domain, which 
means the information must be cited in your text and referenced at the end 
of your manuscript but you do not have to request permission to use it. 

• Material from private publishers—including publishers of your own 
previously published work—requires copyright permission. If per- 
mission is not granted, you cannot use the material in your manuscript. 
»     For all photos, fi      tables, and data from tables from other sources 

that require permission, you must cite the source in your text and 
reference it at the end of your manuscript in addition to crediting the 
copyright holder for permission to use the material. 

• NOTE: Table data do not require copyright permission as long as the 
table is reformatted. However, the material must still be cited, so refer- 
ence information is required. 

3. For those sources that are not in the public domain, request permission from 
the copyright holder to use/reproduce the information. 
• Submit a request letter or the completed Permission Request Form to the 

copyright holder and ask for a reply within 30 days. They should reply di- 
rectly to you, not ASHRAE staff. 

• To request permission to useASHRAE copyrighted content, visit ASHRAE’s 
website. 

4. Be sure to reference all materials from other sources where they appear in 
your manuscript, including credit lines as designated by copyright holders. 

5. Submit permission-granted letters with the completed manuscript. Material 
cannot be published without permission, and no editing or layout work will 
begin on the manuscript until all permissions have been received. 

Obtaining 
Permissions 

http://www.ashrae.org/permissions
http://www.ashrae.org/permissions
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ASHRAE retains exclusive copyright of papers published as part of the ASHRAE 
Winter or Annual Conference Papers download and in ASHRAE Transactions. 
Works published by ASHRAE are fi     and complete works. 

Under ASHRAE copyright policies, authors retain the right for certain specifi 
uses of their paper without requesting ASHRAE’s permission. Only the “as pub- 
lished” version of the paper may be used by the author. These uses are as follows: 

• to make copies of the paper for their own personal use; 
• to make copies and distribute copies of the paper to researchers or cus- 

tomers of the author’s employer for the personal use by such researchers 
or customers; 

• to post the paper as published by ASHRAE on the author’s personal, 
institutional, or corporate website or server with a link to ASHRAE’s 
website; 

• to present the paper (after ASHRAE publication) at a meeting or confer- 
ence and to distribute copies of such paper to the delegates attending the 
meeting with written permission from ASHRAE; 

• to allow use of the paper by the author’s employer for posting on the em- 
ployer’s website, for use by the employer in training or educational cours- 
es offered by the employer, for internal research work that is conducted 
by the employer, and for internal publications published by the employer; 

• to include the paper in full or in part in a thesis or dissertation; 
• to include the paper in a printed compilation of works of the author, such 

as collected writings or lecture notes; and 
• to prepare other derivative works, such as extending the paper into book- 

length form, or to otherwise re-use portions or excerpts in other works, 
providing there is acknowledgement of its publication by ASHRAE. 

Other uses must be authorized by ASHRAE. Authors should contact ASHRAE 
explaining their specifi need and identifying the paper and ASHRAE publication 
in which the paper appeared. 

Others wishing to use ASHRAE copyrighted content should visit ASHRAE’s 
website for more information and to make their request. 

 
Copyright 

http://www.ashrae.org/
http://www.ashrae.org/
mailto:permissions@ashrae.org
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1. Original figures or other artwork should be submitted with the manuscript 
whenever possible. For information on reprinting a figure from another 
source, see Obtaining Permissions. 

2. Use only 1 point (0.014 in. [0.35 mm]) or thicker lines—smaller lines will 
not reproduce well. 

3. Figures to be reproduced in black and white should use patterns or shapes 
to distinguish sections instead of coloring and shading. Figures to be repro- 
duced in color should have touching colors that differ significantly so that 
there can be no confusion in understanding the data. (Note that papers are 
published in color as part of the ASHRAE Winter or Annual Conference Pa- 
pers download and in black and white in ASHRAE Transactions.) 

4. Each figure should have a brief legend or descriptive labels, as appropriate. 
Any text included in a figure (except the figure caption) should be em- 
bedded as part of the image file and not contained in a separate text box 
that is not part of the image file. 

5. Provide dual units for all measurements, preferably as two fi 
6. All figures must be provided to ASHRAE as individual TIF (preferred) or 

EPS files in either CMYK mode (for color) or Grayscale mode (for black 
and white) saved at high resolution (600 dpi or greater) and at least 4 in. 
(102 mm) size or greater. See Converting Graphics Created in Excel or Word 
for instructions on graphic conversion. Figure files should be clearly labeled 
(i.e., Figure1.tif, Fig2.tif, Fig3-2, etc.). Multiple-part fi such as a fi 
with parts (a) and (b), must be submitted as one fi with all parts included. 

7. Every figure must be referenced in the text by name/number, where “Figure” 
is capitalized (e.g., “…as shown in Figure 2.”). 

8. Figures must be numbered consecutively as they appear in the text. 
9. Prepare a list of captions for figures and place it at the end of the manuscript 

(this applies to papers only; it is not applicable for book projects). 

Formatting 
Figures 
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1. All table titles should be descriptive but concise. 
2. Original tables should be submitted with the manuscript whenever possible. 

For information on reprinting a table from another source, see Obtaining 
Permissions. 

3. Titles appear above the tables, and every major word in the title is capital- 
ized. 

4. Number tables consecutively and in the order they are mentioned in the 
text. 

5. Tables used in the manuscript should not be image files but should be alter- 
able tables (such as those created in Word, Excel, Framemaker, InDesign, 
etc.). 

6. Use only 1 point (0.014 in. [0.35 mm]) or thicker lines—smaller lines will 
not reproduce well. 

7. Vertical and horizontal lines should be avoided except to delineate the top 
and bottom of a table and to separate the heading row from the data, unless 
lines are otherwise necessary for clarity or organization of the data. 

8. Label each column with a heading and include units of measurement and 
other necessary qualifying information. Units should be set off with a com- 
ma (e.g., “Velocity, m/s”). 

9. Provide dual units for all measurements. 
10. Every table must be referenced in the text by name/number, where “Table” is 

capitalized (e.g., “as provided in Table 5”). 

Formatting 
Tables 
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ASHRAE policy requires dual units of measurement—inch-pound (I-P) and 
International System of Units (SI). You are required to provide dual units when 
submitting manuscripts; ASHRAE staff will not convert units for you. Some 
guidelines are as follows: 

1. The units used in calculating the work being reported shall be listed first with 
the alternate system of units following in parentheses. 

2. Always spell out all units when they are used without a number. 
3. Do not mix symbols and names in the same expression. 
4. Do not express plurals by adding an “s” 

              5.   Do not use periods with units of 
measurement. 

• EXCEPTION: in. for inch 

6. Leave a space between the numerical value and the unit of measurement. 

• EXCEPTION: There is no space between number and degree of plane angle 
or degrees of temperature (45°, 62°F, 20°C) or the number and the percent 
symbol (5%) 

7. “L” is the symbol for liter, not lowercase “ell” or script “ell.” 
8. “Centi-” is not an acceptable SI prefi and the use of cm should be avoided. 
9. For currency, include the monetary unit of the country where the research is 

based followed by the U.S. dollar conversion in parentheses. 

Units of 
Measurement 
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Each signifi equation or formula should be displayed on a separate line. Center 
equations and place consecutive equation numbers fl right in parentheses. 

EXAMPLE: 
 

where 
a2    = apples 

a2 + b2 = f 2 (1) 

b2    = bananas 
f 2    = fruit salad 

                 If an equation requires more than one line, break it before an operational sign, 
and align the operational signs on the left. 

EXAMPLE: 
E = (a + b + c)/(m + n + o) (2) 

                                                                 × d + e + f) 

If two or more displayed equations are grouped together, leave space between 
the individual equations: 

 

 
Spell out the word “equation” and capitalize it in the text when referring to spe- 
cific, numbered equations. In a highly mathematical or theoretical work, consider 
developing equations in appendices rather than in the body of the manuscript. 

Please note that all equations must be retyped in our pagemaking program— 
this is one reason we require a hard copy of the manuscript—and therefore 
should be checked thoroughly by the author at the proofreading stage. 

a + b = c (3) 

D = f – ab2
 (4) 

mon + rst (5) 

 

Formatting 
Equations 
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Most books are the result of an ASHRAE research project. A subcommittee may 
be designated to handle the review process of a committee-sponsored project, 
using committee members or other persons with expertise in the area of concern. 

The ASHRAE submittal, review, and publication process proceeds as follows: 
1. The author indicates intent to submit a manuscript to Special Publications 

and receives the Authors’ Manual. 
2. The author prepares the manuscript, including artwork, according to this Au- 

thors’ Manual and submits the manuscript to Special Publications (see Book 
Submission Guidelines). 

3. The cognizant ASHRAE Technical Committee selects qualified reviewers. 
4. Reviewers send reviews and comments to the author. 
5. The author revises the manuscript and/or rebuts comments and provides a 

revised manuscript or rebuttal to the cognizant Technical Committee. 
6. Reviewers complete an additional review. 
7. The review process continues until the manuscript is accepted or rejected for 

publication by the cognizant Technical Committee. 
8. After the manuscript is approved for publication, the author submits a final 

Microsoft® Word file and separate figure files electronically to Special Publi- 
cations, and the author is informed of a tentative publication schedule. 

9. Special Publications editors edit the manuscript for grammar, punctuation, 
clarity, and consistency with ASHRAE policies, as well as completeness of 
parts. It is then put into pages, with the figures and tables incorporated. 

10. The editors send a PDF proof to the author, often including queries that 
require responses from the author. The author proofreads the manuscript 
and returns replies to the editors’ queries within a mutually agreed upon 
(hopefully short) timeframe. 

11. The book is published and offered for sale in the ASHRAE Bookstore as 
both the physical, printed book and a PDF available for download. 

12. The author receives a complimentary copy of the published book. 

Book Publication 
Process 

mailto:mowen@ashrae.org
mailto:mowen@ashrae.org
http://www.ashrae.org/bookstore
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Technical Paper and Conference Paper submittal, review, and publication ac- 
tivity is coordinated by the ASHRAE Conference Program Administrator. The 
papers publication process proceeds as follows: 
1. The author indicates intent to submit a paper to the ASHRAE Conference 

Program Administrator and receives instructions and the Authors’ Manual. 
2. The author prepares the paper, including artwork, according to the Authors’ 

Manual and the Author’s Template for Technical Papers or the Author’s Tem- 
plate Conference Papers. 

3. The author uploads the paper through the applicable website as indicated 
in the Technical Papers Submission Requirements and Conference Papers 
Submission Requirements. 

4. The ASHRAE Conference Program Administrator selects qualifi reviewers. 
5. The reviewers carefully review the paper and submit reviews online. 
6. The author receives reviews and comments. The author revises the paper 

and/or rebuts the comments and uploads a revised paper or rebuttal. 
7. The reviewers are notified that a revised paper requires additional review. 
8. The review process continues until the paper is accepted or rejected for 

publication. 
9. After the paper is accepted, the author uploads the fi paper through the ap- 

plicable website in the appropriate format as indicated in the Technical Papers 
Submission Requirements and Conference Papers Submission Requirements. 

10. The accepted paper is scheduled for presentation at an ASHRAE Winter or 
Annual Conference or a Specialty Conference. 

11. ASHRAE staff editors edit and format the Technical Paper and send a PDF to 
the author, who proofreads the paper and returns responses to the editors’ que- 
ries by the supplied deadline, or staff editors scan the Conference Paper for 
adherence to the Author’s Template for Conference Papers and the author ad- 
dresses any noted errors and provides a revised PDF by the supplied deadline. 

12. After the conference editors may send the author of a Technical Paper com- 
ments and questions generated at an ASHRAE Winter or Annual Confer- 
ence. The author returns responses to the editors. 

13. Conference Papers are published as final PDFs on the ASHRAE Winter or 
Annual Conference Papers download, Technical Papers are available as pre- 
print PDFs on the ASHRAE Winter or Annual Conference Papers download 
and published with the questions and comments and authors’ responses in 
ASHRAE Transactions, and papers for Specialty Conferences are published 
as PDFs on flash drives or downloads for the individual conferences. 

Paper Publication 
Process 

mailto:tcox@ashrae.org
http://xp20.ashrae.org/Manuscript/AuthorsTemplate_TechnicalPapers.doc
http://xp20.ashrae.org/Manuscript/AuthorsTemplate_ConferencePapers.doc
http://xp20.ashrae.org/Manuscript/AuthorsTemplate_ConferencePapers.doc
http://xp20.ashrae.org/Manuscript/AuthorsTemplate_ConferencePapers.doc
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The following materials are required for book manuscript submission: 

1. The complete manuscript in Microsoft® Word and the figures provided as 
separate TIF or EPS files saved at high resolution. Tables should be editable 
and NOT submitted as images. 

2. A laser printout of the complete manuscript including text, tables, and graphics. 
With the printout, include a cover sheet with the following information: 

• Proposed title of the book 

• Whether the book will include supplemental materials online (Excel 
spreadsheets, PDFs, Word files, etc.) 

• Sponsoring ASHRAE Technical Committee and/or ASHRAE research 
project number, as applicable 

• Author names in desired order with (if applicable) ASHRAE member- 
ship grade, academic degrees at the doctoral level, and professional 
certifi for each author 

• An “About the Authors” paragraph 

• Complete contact information for the corresponding author, including 
mailing address, phone and fax numbers, and email address 

• A paragraph describing the book (to be used on the back of the book, in 
the bookstore, and in marketing materials) 

3. Electronic or printed copies of any permissions granted for reproducing ma- 
terial from other sources (see Obtaining Permissions) 

4. The completed Marketing Questionnaire 

See Document Formatting and Book Organization for additional requirements. 

Manuscripts should be submitted to: 

Mark Owen 
Editor/Group Manager, ASHRAE Handbook and Special Publications 
1791 Tullie Circle NE, Atlanta, GA 30329 USA 
mowen@ashrae.org Telephone: 678-539-1187 

Book Publication Process provides information on how the process will proceed 
after submission of the manuscript to Special Publications. 

Book Submission 
Guidelines 

http://xp20.ashrae.org/Manuscript/Marketing_Quest_Interactive.pdf
mailto:mowen@ashrae.org
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Technical Papers most often report on ASHRAE-sponsored research and unso- 
licited research in HVAC&R technical areas. 

All Technical Papers undergo critical, double-blind peer review by three or more 
competent specialists to ensure high quality of content. A paper must be accepted 
by three reviewers to be approved for an ASHRAE Winter or Annual Conference. 
The Technical Paper review activity is coordinated by the ASHRAE Conference 
Program Administrator, who can be contacted if you have any questions during 
the paper submission and review process. File submission is done online via 
Manuscript Central. Instructions for uploading files to Manuscript Central are 
available in the “Instructions & Forms” section of that website. 

The Technical Paper submission requirements are as follows: 
1. Upload an Agreement to Publish form that is signed by every author. 
2. Download the Authors’ Template for Technical Papers for a Microsoft® 

Word file to use when writing the paper; also see an example paper. 
3. Typed manuscripts for Technical Papers must not exceed 30 double-spaced 

pages (including references and tables) and can contain a maximum of 12 
figures. Dual units of measurement should be included in the text, tables, 
and figures. See Document Formatting for additional requirements. Upload 
the paper as a Microsoft® Word file for review. Authors should NOT identify 
themselves in manuscript fi     to enable reviewers to maintain a blind review. 

4. Upload an author’s list as a separate Word fi   that includes the following: 
• The title of the paper 
• Author names in desired order, principal author fi with (if applicable) 

ASHRAE membership grade, academic degrees at the doctoral level, and 
professional certifi for all authors. 

• An author note with job title, affi and address for each author. 
• Complete contact information for the corresponding author. 

Reviews will be done using ASHRAE’s online review process, and ASHRAE 
staff editors will edit and lay out the accepted Technical Paper. (See Paper Pub- 
lication Process for more information.) The corresponding author of the paper 
will receive a complimentary print copy of the published paper for distribution 
to all authors. 

Technical Papers 
Submission 

Requirements 

https://www.ashrae.org/membership--conferences/conferences/ashrae-conferences
mailto:tcox@ashrae.org
mailto:tcox@ashrae.org
http://mc.manuscriptcentral.com/ashrae
http://xp20.ashrae.org/Manuscript/AuthorsTemplate_TechnicalPapers.doc
http://xp20.ashrae.org/Manuscript/AuthorsTemplateExample_TechnicalPapers.pdf
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Conference Papers presented at ASHRAE Winter or Annual Conferences report 
on research in progress, applications, case studies, and other topics in HVAC&R 
technical areas. Conference Papers presented at Specialty Conferences report on 
specific technical areas within HVAC&R, depending on the conference. 

All Conference Papers undergo single-blind review by two or more reviewers to 
ensure high quality of content. A paper must be accepted by two reviewers to be 
approved for a conference. The Conference Paper review activity is coordinated 
by the ASHRAE Conference Program Administrator, who can be contacted if you 
have any questions during the paper submission and review process. File submis- 
sion is done online via Conference Exchange using the link provided for each 
individual conference. 
The Conference Paper submission requirements are as follows: 

1. Upload an abstract for review. The abstract must be accepted before the pa- 
per can be submitted. When you upload your abstract you will be assigned 
an ID# for your submission (one ID# for both the abstract and the paper). 

2. Upon acceptance of the abstract, submit the paper based off of the accepted 
abstract. 

• Download the Authors’ Template for Conference Papers for a Microsoft® 

Word file to use when writing the paper; also see an example paper. 
• Conference Papers must not exceed eight single-spaced pages in length 

(including references, tables, and figures) and must include an author 
note at the bottom of page 1. Dual units of measurement should be in- 
cluded in the text, tables, and figures. See Document Formatting for ad- 
ditional requirements. Conference Papers being submitted should be 
considered “Final” by the author. Upload the Conference Paper as a PDF 
with your assigned ID# as the file name. 

• Please note that adherence to the Author’s Template and to the re- 
quirements set forth in this Authors’ Manual are significant factors 
in determining the acceptance of your Conference Paper. 

3. Upload an Agreement to Publish form signed by the presenting author. 
Reviews will be done using ASHRAE’s online review process. (See Paper Pub- 
lication Process for more information.) 

Conference Papers 
Submission 

Requirements 

https://www.ashrae.org/membership--conferences/conferences/ashrae-conferences
mailto:tcox@ashrae.org
https://www.ashrae.org/membership--conferences/conferences
https://www.ashrae.org/membership--conferences/conferences
http://xp20.ashrae.org/Manuscript/AuthorsTemplate_ConferencePapers.doc
http://xp20.ashrae.org/Manuscript/AuthorsTemplateExample_ConferencePapers.pdf
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“Figures to be reproduced in color should have touching colors that differ 
signifi y so that there can be no confusion in understanding the data.” 

 
Sample Figures 

“Figures to be reproduced in black and white should use patterns or 
shapes to distinguish sections instead of coloring and shading.” 
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PERFORMANCE  EVALUATION  FUNCTION  First Level 
 

The performance of any air-conditioning system depends on two factors: 

 
a. thermal comfort 

b. energy consumption 
 

 
The most important variables that influence the condition of thermal comfort are air tempera- 

ture, water vapor pressure in ambient air, relative air velocity, mean radiant temperature, activity 
level (heat production in the body), thermal resistance of the clothing, and purity of the air. 
Fanger (1970) defined a thermal sensation index by considering air temperature, water vapor 
pressure in ambient air, relative air velocity, mean radiant temperature, activity level, and ther- 
mal resistance of the clothing. PMV is the thermal sensation index given by Fanger (1970) and 
is internationally standardized. It is easy to use PMV when controlling an air-conditioning sys- 
tem because PMV is an index of human thermal sensation with one value for all seasons and is 
effective for all temperatures that are neither extremely high nor extremely low. PMV ranges 
from –3 (cold) to +3 (hot). When PMV is zero, then thermal sensation will be neutral, i.e., nei- 
ther cold nor hot. Broadly speaking, when PMV approaches zero then thermal comfort 
increases. 

The first term on the right-hand side of Equation 14 indicates the mass of moisture in the 
incoming air, which comes in contact with the evaporator wall, and the mass of moisture in the 
outgoing air. The humidity of the incoming air is calculated from a psychrometric chart with the 
help of the second-order curve-fitting method. The multiplying factor, (1 – b), corresponds to 
the bypass factor of the evaporator. The second term amounts to mass of moisture in the incom- 
ing air bypassed through the evaporator and the mass of moisture in the outgoing air. The multi- 
plying factor b corresponds to the bypass factor of the evaporator. The rate of change of specific 
humidity of supply air when the evaporator wall temperature is more than the dew-point temper- 
ature is given by 

 

(ρaVd)dWs ⁄ dt = vρa((1 – ξ)W3 + ξW0 – Ws ) . (1) 

 
The first two terms on the right-hand side of Equation 15 correspond to absolute or specific 

humidity of incoming air, and the third term corresponds to outgoing supply air humidity. 

Specific Humidity of Thermal Space. The rate of change of the specific humidity of the 
thermal space is given by 

 

 
Third Level 

Thermal Comfort 

Heading Level 
Samples 

Second Level 
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ASHRAE requires that prospective authors sign an Agreement to Publish form 
that gives ASHRAE the copyright and permits ASHRAE to publish the manu- 
script, to reprint it, and to offer it in whole or in part for reproduction or trans- 
lation. ASHRAE must have the author’s written permission and assignment of 
copyright (for papers) before a manuscript can be processed for publication. 
For books this is likely covered by a publications contract or a research project 
agreement; for papers, authors must complete the Agreement to Publish 
form and either mail it to the address or fax it to the number provided 
on the form or upload it to Manuscript Central (preferred). Authors shall 
not submit manuscripts that are or will be considered for publication by other 
organizations or publishers. 

It is the author’s responsibility to secure and transmit to ASHRAE written per- 
missions for use of proprietary information and/or copyrighted materials ap- 
pearing in the manuscript prior to its submission. (See Obtaining Permissions.) 

ASHRAE requires previously unpublished papers in all its publications. Prior 
publication of papers in publications that are indexed or widely available from 
retrievable sources (including ASHRAE Journal and Science and Technology 
for the Built Environment) usually precludes consideration for presentation at 
Society conferences or for publication in ASHRAE Transactions. 

Agreement to 
Publish Notice 

http://mc.manuscriptcentral.com/ashrae
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Below are steps for converting fi created in Microsoft®  Excel or Micro- 
soft® Word into .TIF fi For additional information see Formatting Figures. 

1. In Excel, select the chart or graph to be converted. In Word, select the 
image to be converted. (Please be sure all elements are grouped together 
before copying.) 
If using Excel 2010 or Word 2010 or newer: 
• From the Home tab, select “Copy.” 

If using Excel 2007 or Word 2007: 
• From the menu options select “Copy.” 

If using an older version of Excel: 
• Hold down the Shift key and from the menu options select “Edit.” 
• Choose “Copy Picture” from the drop-down Edit menu. 
• Select “As shown when printed,” then “OK.” 

If using an older version of Word: 
• From Word’s menu options, choose “Edit” then “Copy.” 

2. Minimize Excel or Word (don’t close it). 
3. Open Microsoft® PowerPoint. 

If using PowerPoint 2007 or 2010 or 2013: 
• Delete the two boxes showing on the blank page that opens. 
• From the PowerPoint menu options, under the Design tab, for 2007 select 

“Page Setup” and for 2010 or 2013 select “Slide Size” then “Custom 
Slide Size.” 

• Set the width for 24 in. and the height for 24 in. and choose “OK.” 
• From the PowerPoint menu options (under the Home tab for 2010 and 

2013), select the drop-down arrow below the “Paste” button and select 
“Paste Special” then “Picture (Enhanced Metafile).” Please make sure all 
elements were copied over into PowerPoint. 

If using an older version of PowerPoint: 
• Choose “Blank Presentation,” then “OK.” 
• Choose the icon showing a completely blank slide (or page); choose “OK.” 
• Under the File menu options, choose “Page Setup.” 
• In Page Setup, set width at 36 in. and height at 24 in. for landscape layout 

and set width at 24 in. and height at 36 in. for portrait layout. Choose “OK.” 
• From the PowerPoint menu options, choose “Edit, Paste Special.” 
• Choose “Picture (Enhanced Metafile).” 

4. Select the image you pasted into PowerPoint. Small squares will appear on 
all four corners. These are handles. Use one of the corner handles to stretch 
the image to fill the page, but be sure to hold down the shift key as you 
stretch the handle so that the image proportions will remain intact. Do 
not stretch the image off the page. 

5. Under the File menu option, choose “Save As.” If using PowerPoint 2013, 
choose “Browse” and navigate to the desired location for saving the file. 

6. In the Save As dialog window, choose “TIFF Tag Image File Format (*.tif)” 
from the Save As Type drop-down list. Give the file a name and click “Save.” 
PowerPoint will ask which slides you want to export; choose “Just This One.” 

Converting 
Graphics 

Created in 
Excel or Word 
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Manuscripts should be double-spaced and in a single-column format on 8 1/2 
by 11 in. (126 by 279 mm) or A4 sheets, with 1 in. (25 mm) margins. 

Authors may submit artwork or suggestions for cover design, but final cover 
designs are at the discretion of ASHRAE. 

 
Title Page. Includes the proposed title of the book, the research project number 
if applicable, the number of the cognizant ASHRAE Technical Committee if ap- 
plicable, and the author names in desired order. 

Table of Contents (TOC). Lists any front matter and each chapter in order. 

Foreword. Optional; usually written by someone other than the author. 

Preface. The preface is the author’s statement about the work. It may include 
general background information, such as reasons for undertaking the work, the 
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